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1 Introduction 
 
 
The Event Capture Graphical User Interface (GUI) User Manual provides instructions for using 
the Event Capture options within the GUI setting. The target audience for this manual includes 
Event Capture managers, application coordinators (ADPACs) and others who use the software. 
 
The GUI provides a consistent, event driven, windows style, user interface for Event Capture. 
The GUI captures all the utilization data that is presently available in Event Capture.  
 
The Event Capture software provides a mechanism to track and account for procedures and 
delivered services that other VistA packages do not handle. The procedures and services tracked 
through Event Capture are associated with the following: 
 

• The patient to whom they were delivered 
• The provider requesting the service or procedure 
• The DSS Unit responsible for delivering the service 

 
DSS Units typically represent the smallest identifiable work unit in a clinical service at a medical 
center and Veterans Affairs Medical Centers (VAMCs) define them.  A DSS Unit can represent 
any of the following: 
 

• An entire service 
• A section of a service 
• A small section within a section 
• A medical equipment item used in patient procedures 

 
The user must define the following items for every DSS Unit: 
 

• Service - The service associated with the DSS Unit.  
• Cost Center - Fiscal identifier for the service using the particular DSS Unit (Cost Centers 

are defined in detail in the MP4-Part V Appendix B of the Fiscal Service cost manuals.)  
• Medical Specialty - The specialty section associated with the DSS Unit. 

 
 
1.1 Sensitive Information  
 
To avoid displaying sensitive information regarding our patients and staff, the examples in this 
manual contain pseudonyms or scrambled data instead of real names.  Our patients and staff will 
be referred to as “ECPATIENT, ONE”, “ECPROVIDER, ONE”, or “USER, ONE.”  Scrambled 
data is a series of random letters that replace a real name like “AAADY, JWHTRE”.  Likewise, 
real social security numbers (SSNs), real addresses and other personal identifiers are not used.  
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1.2 508 Compliant GUI 
 
Section 508 of the Rehabilitation Act Amendments of 1998 requires that when Federal agencies 
develop, procure, maintain, or use electronic and information technology, they shall ensure that 
the electronic and information technology allows persons with disabilities to have access to, and 
use of, information and data that is comparable to the access to and use of information and data 
by persons who are not individuals with disabilities, unless an undue burden would be imposed 
on the agency.  
 
The Section 508 Accessibility Testing and Training Center (T&TC) was consulted and 
modifications to the GUI have been made to meet the requirements for 508 Compliance.  Event 
Capture was modified to allow screen readers to accurately interpret information on the screens. 
As a result, some buttons and boxes have been moved, replaced or renamed and some screen 
titles have been modified.  
 
For more information on the VA 508 Compliance efforts, please visit the following website 
http://www.va.gov/oit/ea/section508/ . 
 
 
1.3 Related Manuals 
 
The documentation for Event Capture V. 2.0 includes the following related manuals. 
 

• Event Capture Monograph 
• Event Capture V2.0 Installation Guide 
• Event Capture V 2.0 Technical Manual 
• Event Capture V 2.0 User Manual 
• Event Capture GUI Release Notes 

 
These documents can be found at:  
http://www.va.gov/vdl/application.asp?appid=39 

http://www.va.gov/oit/ea/section508/
http://www.va.gov/vdl/application.asp?appid=39
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1.4 Event Capture Online Documentation 
 
Throughout the entire Event Capture system, click on the question mark, option located at the 
toolbar       or on the bottom right corner of the screen                   , to obtain online information 
for any screen.  This help corresponds with the information that is in the User Manual. 
 
To obtain online information for a field, click on that field and then press <F1>. 
 
Example:  Online Help Screen 
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1.5 Event Capture Interface with CPRS 
 
Access to Event Capture is possible via the Computerized Patient Record System (CPRS).  The 
intention of this design was to increase the use of Event Capture by clinicians currently using 
CPRS.  The creation of a link and a single point of entry make it so users can access both 
systems.  
 
The interface between CPRS and Event Capture allows users to: 

• Access Event Capture from within CPRS through a single sign-on 
• Select Event Capture Interface in the CPRS Tool Menu allowing the user to enter Event 

Capture patient procedures 

 
1.6 Timeout Feature 
 
Event Capture includes a timeout feature consistent with CPRS.  A countdown screen will 
display warning of the pending timeout of the application when the Event Capture application is 
idle for a user-defined amount of time.  If the user takes no action, the application will close.  
The amount of time for the timeout and countdown features is user-defined at the application 
server level.  Click on the                                          button to stay connected. 
 
Example: Event Capture Timeout Screen 
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2 Orientation 
 
The design of the Event Capture User Manual is for use as an instructional guide to using the 
Event Capture software.  The user can use this manual in conjunction with the Event Capture 
GUI Online help option.  
 
Screen displays may vary among different sites and the data may not appear on the terminal 
exactly as shown in this manual.  Although screens are subject to modification, the major menu 
options as they appear in this manual are fixed and are not subject to modification (except by the 
package developer). 
 
 
2.1 Online Help 
 
Help is available at almost any prompt in the Event Capture application.  Pressing <F1> will 
provide the needed information to help the user answer the prompt.  
 
 
2.2 Frequently Asked Questions (FAQ) 
 
How can I access the Event Capture Graphical User Interface (GUI)? 
Users need an Access Code and Verify Code obtained from their local Information Resource 
Management (IRM) staff to use the Event Capture (GUI). 
 
How do I logon to the Event Capture GUI? 
Event Capture is usually accessed through a desktop shortcut that points to the installation 
location. Ask the local support staff for assistance.  
 
What other logon problems should I anticipate? 
If Event Capture launches then it disappears or is not responding, check your firewall (for 
example, Black Ice).  Make sure the listed IP address is correct and not blocked for the system 
with which it is communicating.  Your local support staff can assist you. 
 
What can cause the GUI to appear distorted? Missing scrollbars? Missing columns or 
missing rows? 
The screen resolution needs to be set to 96 dots per inch (DPI). 
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Follow the instructions below to set the screen resolution to 96 DPI: 
1. Right-click on the desktop and then select Properties. 

 
      Example:  Desktop Menu Displayed After Right-Click 
 

 
 

2. On the Settings tab, click the Advanced button. 
 

       Example:  Setting tab on Properties Screen   
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3. Select “Normal size (96 DPI)” from the DPI Setting dropdown box and then click OK. 

 
Example:  Menu Displayed After Selecting Advanced button 
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3 Before Using the Software 
 
 
Event Capture must be setup by using the options in the Event Capture Management Menu 
before any data can be entered.  Access to this menu should be restricted to the ADPAC and his 
or her designees.  The Event Capture ADPAC should use the following steps as a guide for 
setting up the Event Capture software.  
 
1. Use the Location - Update Location Information option to create an Event Capture location.  
 

Notes: 
• No further options are functional until an Event Capture location is created. 
• The selected location must be in the INSTITUTION file (#4). 
• A location must be created with this option before DSS Units can be established. 

 
2. Contact each service for a list of its DSS Units, the names of its Event Capture users, and the 

DSS Units for which they will enter data, and for individual product resource tracking needs. 
Use the DSS Unit - Add or Update DSS Units option to establish DSS Units for each service.  

 
Note: 
• No further options are functional until the DSS Units are created. 

 
3. Use the Access by User - Grant Access to DSS Units by User option to assign user access to 

specific DSS Units for the users identified in Step 2.  Assign the ECALLU security key only 
to those users who should have access to all DSS units. 

 
Notes: 
• Users must have access to DSS Units before they can begin entering data. 
• Use the Access by User – Grant Access to DSS Units by User option to remove user 

access for a specific DSS Unit, except for those users who have the ECALLU security 
key, which overrides user access removal. 

 
4. Use the Category - Add or Update Categories option to create local categories before the user 

sets up Event Code screens.  Creating local categories is optional.  
 

Helpful Hint: 
• After completion of this step, the Category Report option on the Reports Menu can be 

used to print a report of the site’s local categories. 
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5. Use the Procedure - Add or Update Local Procedures option to enter new or edit existing 
local procedures to the EC NATIONAL PROCEDURE file (#725).  Adding local procedures 
is optional.  

 
Helpful Hint: 
• Before starting this step, use the National/Local Procedure Report option on the Reports 

Menu to print a list of procedures with their associated CPT codes.  This report can be 
quite lengthy if it includes national procedures, so it should be queued to print to a device 
during non-peak hours. 

 
Notes: 
• An associated CPT code must be entered to pass local procedures to PCE. 
• Use this option to edit, but not delete, existing local procedures and to select an 

associated CPT code if this workload data should be sent to PCE. 
 
6. Use the Event Code Screen - Add or Update Event Code Screens option to: 

• Create an event code screen for each procedure tracked in the Event Capture software.  
• Enter or edit an active associated clinic for DSS Units that are marked to send data to 

PCE. If an Associated Clinic has non-conforming stop codes, the clinic will not be 
selectable.  

• Enter or edit a procedure Synonym. 
• Enter or edit procedure Reason(s).  
• Enter or edit procedure default Volume. 

 
Note 
• A screen for the procedure must be created before it can be used for data entry. 

 
7. Use the Print Category and Procedure Summary (Report) option on the Reports Menu to 

print the Event Code screens sorted by DSS Units.  
 

Helpful Hint 
• Data entry clerks might find the output generated by this report useful as a procedure 

reference guide.   
 

8. Set up of Event Capture is complete. Services can now enter data using the Data Entry 
options and provide summary reports using the Reports options.  
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4 Logon 
 
 
Access to Event Capture occurs through a desktop shortcut that will point to the installation 
location.  Refer to the Installation Guide for Event Capture or ask the local support staff for 
assistance.  
 
Example:  ECS GUI Icon 

 
 
 
 

The VistA Sign-on screen will display.  Enter your VistA Access Code and Verify Code. 
 
Example: VISTA Sign-on Screen 
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5 Event Capture Main Menu 
 
 
The Event Capture software contains four menus.  The user must hold the appropriate security 
keys to have access to the Spreadsheet menu (ECSPSH) and to the Management Menu 
(ECMGR) and their options.  To remove the Reports menu for a user, add the ECNORPT 
security key.  
 
The following Main Menu options display when the Event Capture opens. 
 
Example: Main Menu for Event Capture 
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Example: Main Menu with the ECNORPT Security Key Added for the User  
 

 

5.1 Icon Shortcuts 
 
There are ICON shortcuts to access options in Event Capture. 
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5.2 Menu Bar 
 
The Event Capture menu bar allows the user to access shortcut commands.  
 
Example: Main Menu Bar 
 

 
 
The File menu allows you to Exit the window.  The Function Menu on the Main window 
provides access to Data Entry, Spreadsheet, Reports and Management Menu functions.  The View 
menu allows the user to show or hide the Toolbar and Status Bar.  Help provides topic specific 
help or information about the Event Capture system. 
 
Example: Main Menu Bar with Menus Expanded 
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5.3 Menu Bar for Specific Functions 
 
5.3.1 Data Entry Menu Bar 
 
Example: Data Entry Menu Options 
 

 
 
The File menu allows the user to Exit the window.  The Edit Menu on the Main window provides 
access to Data Entry by Patient, Data Entry by Procedure and Multiple/Multiple functions.  The 
View menu allows the user to show or hide the Toolbar and Status Bar.  Help provides topic 
specific help or information about the Event Capture system. 
 
Example: Data Entry Menu with Menus Expanded 
 

 
 
5.3.2 Spreadsheet Menu Bar 
 
Example: Spreadsheet Upload Options 
 

 
 
The File menu allows the user to Exit the window as well as Open, Close, Save, Save As and 
Print a file.  The Edit Menu on the Main window provides access to Cut, Copy, Paste, Insert Row 
and Delete Row functions.  The EC Upload menu allows the user to Upload Records to VistA. 
The Spreadsheet Options menu allows the user to Change Column Headers or Change Duplicate 
Threshold.  Help provides topic specific help or information about the Event Capture system. 
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Example: Spreadsheet Menu with Menus Expanded 
 

   
 
 

 
 
 
5.3.3 Reports Menu Bar 
 
Example: Reports Menu Bar 
 

 
 
The File menu allows the user to Exit the window.  The View menu allows the user to show or 
hide the Toolbar and Status Bar.  Help provides topic specific help or information about the 
Event Capture system. 
 
Example: Reports Menu with Menus Expanded 
 

 
 
 
 
 

 
5.3.4 Management Menu Bars 
 
Example: Management Menu Options 
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The File menu allows the user to Exit the window.  The Table Menu on the Main window 
provides access to Location, DSS Unit, Access by User, Category, Procedure, Event Code Screen 
and Inactivate EC Screen functions.  The View menu allows the user to show or hide the Toolbar 
and Status Bar.  Help provides topic specific help or information about the Event Capture system. 
 
Example: Management Menu with Menus Expanded 
 

  
 
 
 
 
 
 
 
5.4 Default Location to all Enter/Edit Screens 
 
On all Event Capture screens, the previous Location entry will be “saved” and used as the default 
on subsequent Location fields.  
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6 Data Entry Menu 
 
The Data Entry menu offers the following options: 
 

• Data Entry by Patient – Enter/Edit Patient Procedures 

• Data Entry by Procedure – Batch (Same Procedure, Multiple Procedures) 

• Multiple Dates/Procs – Multiple Dates / Multiple Procedures 

Example:  Data Entry Menu Screen 
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6.1 Data Entry by Patient  
 
6.1.1 Before the User Starts 
Use this option to: 

• Enter a single procedure for one patient 

• Enter multiple procedures for one patient 

• Edit an existing patient procedure 

• Delete an existing patient procedure  

Event Code screens must be defined before entering any Event Capture data. 

 
6.1.2 What the User Will See 
 
• A summary screen to identify the Location, DSS Unit, Procedure Date Range, Patient 

Identifier and the Procedures for that patient 

• A Detail screen to show the detailed information about a selected procedure 
 
Example: Summary Screen for Enter/Edit Patient Procedures 
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6.1.3 Instructions for Enter/Edit Patient Procedures Screen 
 
1. Select a Location. 

• If there is only one Location set up for the Event Capture System, the Location on the 
screen will default to that value.  

• If there is more than one Event Capture Location set up, the Location will default to the 
last Location used.  To change the Location, choose a Location from the dropdown list of 
available Event Capture Locations. 

2. Select a DSS Unit. 

• If one DSS Unit is defined in the Event Capture Management Menu for DSS Unit, or if 
only one DSS Unit is assigned to the user, that DSS Unit value will default. 

• If more than one DSS Unit is defined, a default will not be assigned. Choose a DSS Unit 
from a dropdown list of accessible DSS Units. 

• The user can add, edit or delete any patient procedure for the selected DSS Unit.  

• To gain access to a DSS Unit, go the Management Menu and choose the DSS Unit - Add 
or Update DSS Units function to add the unit to the dropdown list. (Note: The ECMGR 
key is required) 

3. Select a Date Range.   

• The Procedure Date Range (from/through) will default to the system date.  These fields 
may be edited by typing in a date (dd mmm yyyy) or by using the calendar dropdown.  

Note: An edit check will prevent selecting a date in the future or selecting Procedures 
From date that is later than the Procedures Through date. 

         Example: Calendar Dropdown for Date Range View  

 

•  
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4. Use the Patient Identifier field to select a patient. 

• Enter one of the following: 

 Patient Name (whole or partial, last name first) 

 Social Security Number 

 Last four digits of the Patient Social Security Number 

 First character of Last Name plus the last four digits of the SSN with no spaces 

• Press <Enter> or the Search button. 

• Choose from the list of patients displayed. 

5. Once the previous steps are complete, the bottom section of the window will display the 
Procedure History in chronological order for the selected patient at the selected DSS Unit for 
the date range specified.  The Procedure History will display the Category, Procedure, 
Date/Time, Volume, Associated Clinic, Ordering Section, Primary Diagnosis and Primary 
Provider.  

Note: Click on the field header to sort the data in a different order. 

Note:  All buttons at the bottom of the screen (Close, Add, Update, Delete and Topic Help) 
are active. 

       Example:  Procedure History for Sample Patient 
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Note: Clicking on a previously entered Procedure, shown on the lower half of the Enter/Edit 
Patient Procedure screen, will highlight the procedure and activate the Update and Delete 
buttons. 

6. Click the Add button                     to do data entry.   

7. Click the Update button                    to display the procedure on the Edit Patient Procedure 
(Detail) screen. 

8. Click the Delete button                     to delete the procedure from patient’s record.   
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6.1.4 Recent Visits Pop-up Screen 
1. Click the Add button                     to do data entry.  The Recent Visits pop-up screen will 

display. 

Example: Recent Visits Screen 

 
2. On the Recent Visits pop-up box, take one of three options: 

a. Select the appropriate Appointment/Encounter from the Recent Visits. Click OK             
to close the pop-up box.  The Add Patient Procedure screen will display, which will have 
the Procedure Date & Time and Associated Clinic populated and locked, based on the 
Appointment/Encounter selected on the Recent Visits pop-up box. Enter the procedure(s), 
answer classification questions as they pertain to that visit if not grayed out, and enter 
diagnoses, provider, and other pertinent fields if required (reasons, ordering section 
and/or modifiers). 

Note:  If the Associated Clinic for the record is no longer active, the Error: Invalid 
Associated Clinic pop-up will appear.  The pop-up only lists active associated clinics.  To 
update the record, select an active clinic from the list and then OK                    .  Select 
Cancel                    to open the record and Associated Clinic will be blank. 
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Example:  Invalid Associated Clinic Pop-up 

  
 

b. Click Ignore                     on the Recent Visits pop-up to go to unfilled Add Patient 
Procedure screen to enter detail for all fields.   

c. Click Cancel                      to close the Recent Visits pop-up and stay at the Enter/Edit 
Patient Procedure screen. 
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Example:  Add Patient Procedure (or Edit Patient Procedure) Detail Screen 
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6.1.5 Adding Information to the Add Patient Procedure or Edit 
Patient Procedure Screen 

 
To complete the Add Patient Procedure or Edit Patient Procedure screen: 

1. Select a Category 
• If only one category is defined for the specified DSS Unit, that category will default. 
• If the Allow Category field in the Add DSS Unit Management set up is set to NO, then 

Category field will be blank and disabled. 

2. Select the Procedure Date and Time.  
• This information is complete if an appointment selection occurred on the Recent Visits 

pop-up. 
• Type “N” and then press <Enter> in the field instead of clicking the      button will 

bypass the pop-up or clicking Now on the pop-up will enter the current system date and 
time. Use of the Now button will append seconds onto the entry, causing a duplicate entry 
when used in conjunction with CPRS. 

Example: Select Date/Time Pop-up 

  
 

3. Select an Eligibility Code for this procedure. 
• If the selected patient has only one Eligibility Code, that value defaults.  Otherwise, select 

the Eligibility Code that applies to this procedure.  
• The primary Eligibility Code displays as the default. 

4. Select a Procedure Name. 
• Select a procedure from the dropdown list. 

5. Enter the Volume for the procedure. 

6. If applicable, the CPT Modifiers section will be active. 
• Modifiers provide additional information about a CPT procedure.  With functionality put 

in place by the Code Set Versioning project, only CPT modifiers that are active for the 
date and time of the event will show. 
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• Choose a Modifier from the Modifiers Available list and click Include.  
• Repeat as needed.   
• To remove a modifier, choose it from the Modifiers Selected list and click Exclude.  
• Press <CTL-Click> to select multiple Modifiers at one time. 

7. If applicable, the Reasons field will be active.  
• The user can enter up to three reasons. 
• Reason #1 must be entered before a second or third may be entered. Reason #2 must be 

entered before a third may be entered. 
• A reason will not appear in the dropdown for remaining reason fields as an option once 

selected. 

8. If applicable, the mandatory classification questions section will be active. 
• Select YES only if the treatment received relates to that classification. 
• Press <F1> while in the Service-Connected field will open a pop-up window displaying 

the patient’s service connection and any rated disabilities. 
 

Example: Service Connection and Rated Disabilities Screen 
 

 
 

9. Select the Ordering Section. 

10. Select the associated ICD-9 diagnosis codes for the procedure. 
• Use the Primary field to enter one of the following: 
 ICD-9 code (whole or partial) 
 Diagnosis Name (whole or partial) 

• Press the Search button.  
• Select from the resulting dropdown list. 
• Repeat as needed to select the Secondary Diagnosis Codes. 

11. Select the Associated Clinic (if not already populated from Recent Visits pop-up). 
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12. Select the providers of the services. 
Use the Providers Available text box to enter the following: 
• Provider name (full or partial, last name first) 
• Select the provider from the resulting dropdown list and click Include.  
• To remove a provider, select from the Providers Selected list and click  

Exclude.  
 
13. Click the Add button                   to save the edited procedure. 
14. Click the OK button                  to save the edited procedure and return to the Enter Patient 

Procedure screen. 
15. Click the Cancel button                  to return to the Enter Patient Procedure screen without 

saving the above entries. 
 
Notes 

• If the record transmits to PCE based on the DSS Unit on Management Menu set up, then 
all fields will be required. 

• If the record does not transmit to PCE based on the DSS Unit on Management Menu set 
up, then the Associated Clinic and the four Secondary Diagnosis fields will be disabled.  

• Press <F1> while in any field to open a pop-up window displaying a Help message. 
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6.1.6 Add a Patient Procedure 
 
The following instructions and example assume that a user is entering a new procedure for a 
specified patient and that the specified DSS Unit data transmits to PCE. 
 
Instructions to Add a Patient Procedure 
 
1. On the Main Menu, select Data Entry. 
2. On the Data Entry Menu, select Entry by Patient. 
3. The Edit Patient Procedures screen appears.  
4. Select the Location and DSS Unit. 
5. Allow Procedure Date Range to default to today. 
6. Select a Patient. 

Example:  Edit Patient Procedure Summary Screen 

 
 
7. Click Add.                      
8. The Recent Visits screen will appear.  Click Ignore.  
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Example:  Add Patient Procedure Detail Screen 

 
 

9. Complete the procedure related fields on the Add Patient Procedure detail screen according to 
the field-by-field instructions given earlier. 

10. Click Add                    to save the Detail entries and open another Detail screen for this 
patient. 

11. Click OK                   to save the Detail entries and return to the Enter/Edit Patient Procedures 
screen. 

12. The Enter/Edit Patient Procedures screen will display the procedure(s) entered for this 
patient. 

13. Click Close                   to return to the Data Entry menu. 
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Example:  Enter/Edit Patient Procedures with New Procedure Added 
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6.1.7 Edit a Patient Procedure 
 
To edit an existing patient procedure 
 
1. On the Main Menu, select Data Entry. 
2. On the Data Entry Menu, select Entry by Patient. 
3. The Enter/Edit Patient Procedures screen appears. 
 
Example: Enter/Edit Patient Procedures Summary Screen 
 

 
 
4. Select the Location and DSS Unit. 
5. Enter a Procedure Date Range by using the calendar dropdowns. The default is today. 
6. Select a Patient. 
7. The lower portion of the screen will display the procedure(s) for the selected patient and the 

DSS Unit within the date range. 
8. Choose a procedure and click Update.  
9. The Edit Patient Procedure screen appears. 
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Example: Edit Patient Procedure Screen 
 

 
 

 
10. Complete the procedure related fields on the Edit Patient Procedure detail screen according to 

the field-by-field instructions given earlier. 
11. Click Add                    to save the detail entries and open another detail screen for this 

patient. 
12. Click OK                   to save the detail entries and return to the Enter/Edit Patient Procedures 

screen. 
13. The Enter/Edit Patient Procedures screen will display the procedure(s) entered for this 

patient. 
14. Click Close                   to return to the Data Entry menu. 
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6.1.8 Delete a Patient Procedure 
 
To delete an existing patient procedure 
 
1. On the Main Menu, select Data Entry. 
2. On the Data Entry Menu, select Entry by Patient. 
3. The Enter/Edit Patient Procedures screen appears. 
 

 
 
4. Select the Location and DSS Unit. 
5. Enter a Procedure Date Range by using the calendar dropdowns.  The default is today. 
6. Select a patient. 
7. The lower portion of the screen will display the procedure(s) for the selected patient and the 

DSS Unit within the date range. 
8. Choose a procedure and click Delete.  
9. A confirmation message appears.   

• Click Yes and a pop-up appears to show the selected procedure was deleted for the 
patient.  Click OK to return to the Enter/Edit Patient Procedures screen.   

• Click No to return to the Enter/Edit Patient Procedures screen. 
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Example: Confirmation Message  Example:  Procedure Deleted Pop-up 

 
 
 
 
 
 
 

10. The screen will now refresh to show the remaining procedures entered for this patient. 

Example: Enter/Edit Patient Procedures Screen with Procedure Deleted 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
11. Click Close                    to return to the Data Entry menu. 
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6.2 Data Entry by Procedure 
 
6.2.1 Before the User Starts 
  

• Enter / edit the same procedure for multiple patients 
• Event Code screens must be defined before entering any Event Capture data. 
• Use the Data Entry by Patient option to make corrections to erroneous patient data. 

 
6.2.2 What the User Will See 
 

• The left half of the screen contains information for the procedure that the user will add for 
each patient.  
Note: The user will enter the procedure information only one time. 

• The right half of the screen identifies each patient.  The user will complete this section for 
each patient.  Click Add                    to get a refreshed screen for the next patient. 

• The View                    button displays a listing of all patients entered for this procedure in 
this session. 
 

Example: Same Procedure, Multiple Patients Screen 
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6.2.3 Instructions for Adding a Procedure for Multiple Patients 
 
The following instructions and example assume that the user wants the specified DSS Unit to 
send data to PCE. 
 
1. Select a Location. 

• If there is only one Location set up for the Event Capture System, the Location on the 
screen will default to that value.  

• If there is more than one Event Capture Location set up, the Location will default to the 
last Location used.  To change the Location, choose a Location from the dropdown list of 
available Event Capture Locations. 

2. Select a DSS Unit. 

• If one DSS Unit is defined in the Event Capture Management Menu for DSS Unit, or if 
only one DSS Unit is assigned to the user, that DSS Unit value will default. 

• If more than one DSS Unit is defined, a default will not be assigned. Choose a DSS Unit 
from a dropdown list of accessible DSS Units. 

• The user can add, edit or delete any patient procedure for the selected DSS Unit.  

• To gain access to a DSS Unit, go the Management Menu and choose the DSS Unit - Add 
or Update DSS Units function to add the unit to the dropdown list. 

3. Select a Category. 
• If only one category is defined for the specified DSS Unit, that category will be the 

default. 

4. Select the Procedure Date and Time. 
• Type “N” and then press  <Enter> in the field instead of clicking the      button will 

bypass the pop-up or clicking Now on the pop-up will enter the current system date and 
time 

Example: Select Date/Time Pop-up 
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5. Select a Procedure Name. 
• Select a procedure from dropdown list. 

6. If applicable, the Reasons field will be active.  
• The user can enter up to three reasons. 

•  Reason #1 must be entered before a second or third may be entered. Reason #2 must be 
entered before a third may be entered.A reason will not appear in the dropdown for 
remaining reason fields as an option once selected. 

7. If applicable, the CPT Modifiers section will be active. 
• Modifiers provide additional information about a CPT procedure.  With functionality put 

in place by the Code Set Versioning project, only CPT modifiers that are active for the 
date and time of the event will show. 

• Choose a Modifier from the Modifiers Available list and click         .  Repeat as needed. 

• To remove a modifier, choose it from the Modifiers Selected list and click         .  

• Press <CTL-Click> to select multiple Modifiers at one time. 

8. Select the providers of the services. 
Use the Providers Available text box to enter the following: 
• Provider name (full or partial, last name first) 

• Select the provider from the resulting dropdown list and click         .  

• To remove a provider, select from the Providers Selected list and click         .  

9. Use the Patient Identifier field to select a patient. 
• Enter one of the following: 
 Patient Name (whole or partial, last name first) 
 Social Security Number 
 Last four digits of the Patient Social Security Number 
 First character of Last Name plus the last four digits of the SSN with no spaces 

• Press <Enter> or the Search button. 

• Choose from the list of patients displayed.  

10. Select an Eligibility Code for this procedure. 
• If the selected patient has only one Eligibility Code, that value defaults.  Otherwise, select 

the Eligibility Code that applies to this procedure.  

• The primary Eligibility Code displays as the default. 

11. Enter the Volume for the procedure. 
 
12. If applicable, the mandatory classification questions section will be active. 

• Select YES only if the treatment received relates to that classification. 

• Press <F1> while in the Service-Connected field will open a pop-up window displaying 
the patient’s service connection and any rated disabilities. 
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Example: Service Connection and Rated Disabilities Screen 

 
 
13. Select the Ordering Section. 

14. Select an Associated Clinic for the specified DSS Unit, if applicable. 

15. Select the associated ICD-9 diagnosis codes for the procedure. 
• Use the Primary field to enter one of the following: 
 ICD-9 code (whole or partial) 
 Diagnosis Name (whole or partial) 

• Press the Search button.  

• Select from the resulting dropdown list. 

• Repeat as needed to select the Secondary Diagnosis Codes.  

16. Click the Add                  button to add this procedure for the patient. The right side of the 
screen will reset to enter this procedure for another patient.  Select the next patient for this 
procedure. Repeat the patient related steps above. 

17. Click the OK                 button to add this procedure to the patient’s record and return to the 
Data Entry menu. 

18. Click the View                 button to verify that the list of patients entered is correct. The 
following screen will list all of the patients entered for the procedure that you selected 
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Example: View Patients for this Procedure Screen 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
19. To correct an entry, return to the Data Entry menu and select Data Entry by Patient. 
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6.3 Multiple Dates / Procedures 

 
6.3.1 Before the User Starts 
• Add multiple dates and multiple patients for multiple procedures 
• Event Code screens must be defined before entering any Event Capture data. 
• Use the Data Entry by Patient option to make corrections to erroneous patient data. 
 
6.3.2 What the User Will See 
• An area at the top of the first screen for entering common fields (Location, DSS Unit and 

Category) as well as the Procedure Date/Time 
• Three tabs for entering providers, procedures and patients. 
• Two tabs for checking work before submitting. 
  
Example:  First Screen Encountered Upon Entering Multiple Dates/Multiple Procedures 
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6.3.3 Instructions for Common Fields 
 
1. Select a Location. 

• If there is only one Location set up for the Event Capture System, the Location on the 
screen will default to that value.  

• If there is more than one Event Capture Location set up, the Location will default to the 
last Location used.  To change the Location, choose a Location from the dropdown list of 
available Event Capture Locations. 

2. Select a DSS Unit. 

• If one DSS Unit is defined in the Event Capture Management Menu for DSS Unit, or if 
only one DSS Unit is assigned to the user, that DSS Unit value will default. 

• If more than one DSS Unit is defined, a default will not be assigned.  Choose a DSS 
Unit from a dropdown list of accessible DSS Units. 

• The user can add, edit or delete any patient procedure for the selected DSS Unit.  

• To gain access to a DSS Unit, go the Management Menu and choose the DSS Unit - Add 
or Update DSS Units function to add the unit to the dropdown list. 

3. Select a Category. 
• If only one category is defined for the specified DSS Unit, that category will be the 

default. 

4. Select the Procedure Dates and Times by using the Select Date/Time popup window. 

5. Type “N” and press <Enter> in the field instead of clicking the      button will bypass the 
pop-up or clicking Now on the pop-up will enter the current system date and time. 

Example: Select Date/Time Pop-up 
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• Select a date and time and click OK to return to close the pop-up. 
• Click the Add Date/Time                          button to add the choice to the Selected Dates 

list.   
• Select and add additional dates as needed.   
• To remove a date, choose it from the list and click the Delete Date/Time    

button. 

6. Click and complete the tabs for Providers, Procedures and Select Patient as described below.   

7. Use the View Selected Patients and Records Pending Filing tabs to check the work as 
described below. 

8. Click the Save                   button at the bottom of the screen to process the transactions 
shown on the Records Pending Filing tab and then redisplay the screen initialized for a new 
set of entries.  

9. Click the OK                  button at the bottom of the screen to process the transactions shown 
on the Records Pending Filing tab and then return to the Data Entry menu. 
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6.3.4 Adding Information to Providers Tab 
 
1. Click on the Providers tab to select one or more providers. 
 
Example:  Providers Tab on Multiple Dates/Multiple Procedures Screen 
 

 
 
2. Select a Provider. 

• Use the Providers Available text box to enter the full or partial Provider name (last name 
first) 

• Select the provider from the resulting dropdown list and click Include.  

• To remove a provider, select from the Providers Selected list and click Exclude. 

3. Repeat as needed to add additional providers.  
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6.3.5 Adding Information to Procedures Tab  
 
1. Click on the Procedures tab to select one or more procedures.  
 
Example:  Procedures Tab on Multiple Dates/Multiple Procedures Screen 
 

 
 
2. Select a Procedure Name. 

• Select a procedure from dropdown list.   

3. Enter the Volume for this procedure. 

4. If applicable, the Reasons field will be active.  
• The user can enter up to three reasons. 

•  Reason #1 must be entered before a second or third may be entered. Reason #2 must be 
entered before a third may be entered. 

• A reason will not appear in the dropdown for remaining reason fields as an option once 
selected. 
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5. If applicable, the CPT Modifiers section will be active. 
• Modifiers provide additional information about a CPT procedure.  With functionality put 

in place by the Code Set Versioning project, only CPT modifiers that are active for the 
date and time of the event will show. 

• Choose a Modifier from the Modifiers Available list and click Include.  
• Repeat as needed.   
• To remove a modifier, choose it from the Modifiers Selected list and click Exclude.  
• Press <CTL-Click> to select multiple Modifiers at one time. 

6. Click the Add Procedure                             button to add this procedure to the Procedures 
Selected list and display a blank screen ready for another entry. 

7. To add another procedure, repeat the steps above. 

8. To delete a procedure, choose it from the Selected Procedures list and click the Delete 
Procedure                             button. 

9. To view a procedure in an expanded format, choose it from the Selected Procedures list and 
click the View Details                            button.  The View Procedure Record Details screen is 
not editable. 

Example: View Details Screen 

 
 
10. Click the Close Procedure View                                  button to return to the Procedures tab. 
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6.3.6 Adding Information to Select Patient Tab 
 
1. Click on the Select Patient tab to select one or more patients. 
 
Example:  Select Patient Tab on Multiple Dates/Multiple Procedures Screen 
 

 
 
2. Use the Patient Identifier field to select a patient. 

• Enter one of the following: 
 Patient Name (whole or partial, last name first) 
 Social Security Number 
 Last four digits of the Patient Social Security Number 
 First character of Last Name plus the last four digits of the SSN with no spaces 

• Press <Enter> or the Search button. 

• Choose from the list of patients displayed.  

3. Select an Eligibility Code for this procedure. 
• If the selected patient has only one Eligibility Code, that value defaults.  Otherwise, select 

the Eligibility Code that applies to this procedure.  
• The primary Eligibility Code displays as the default. 
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4. If applicable, the mandatory classification questions section will be active. 
• Select YES only if the treatment received relates to that classification. 
• Press <F1> while in the Service-Connected field will open a pop-up window displaying 

the patient’s service connection and any rated disabilities. 
 

Example: Service Connection and Rated Disabilities Screen 
 

 
 

5. Select the Ordering Section. 

6. Select the Associated Clinic. 

7. Select the associated ICD-9 diagnosis codes for the procedure. 
• Use the Primary field to enter one of the following: 
 ICD-9 code (whole or partial) 
 Diagnosis Name (whole or partial) 

• Press the Search button.  
• Select from the resulting dropdown list. 
• Repeat as needed to select the Secondary Diagnosis Codes. 

8. Click the Add Patient                         button to add this patient to the list of Selected Patients 
and display a blank screen ready for another entry. 

9. Use the View Selected Patients tab to check the work. 
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6.3.7 Using View Selected Patients Tab to Verify Information 
 
1. Click on the View Selected Patients tab to review the list of selected patients. 
 
Example:  View Selected Patient Tab on Multiple Dates/Multiple Procedures Screen 
 

 
 
2. To remove a patient from the list, select it and click the Delete Patient                           

button.  Click Yes on the Confirmation pop-up. 

Example:  Deleting Patient Confirmation Pop-up  

 
 

3. To view a patient in an expanded format, choose it and click the View Details            
button.  The View Patient Record Detail screen is not editable. 
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Example: View Patient Record Details Screen 

 
 
4. Click the Close Patient View                              button to return to the View Selected 

Patients tab. 
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6.3.8 Using Records Pending Filing Tab to Verify Information 
 
1. Click on the Records Pending Filing tab to view a list of the records to be filed.  

Note:  This screen is not editable. 
 
Example:  Records Pending Filing Tab on Multiple Dates/Multiple Procedures Screen 
 

 
 
2. This screen lists the individual records (transactions) that will be processed when the OK                

or Save                 button at the bottom of the screen are clicked.  A pop-up will appear on the 
screen to show the number of records added.  
Note:  Click OK to return to the Data Entry menu or click Save to add additional entries. 

Example:  Information Popup after Saving 
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3. The records consist of every combination of the dates, procedures, and patients selected on 
the tabs described above and the providers selected will be assigned to each record. 

4. To change the list, review and revise the selections on the Providers, Procedure and Select 
Patient tabs and for the Selected Dates/Times field. 

5. To correct an entry, return to the Data Entry menu and select Data Entry by Patient. 
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7 Spreadsheet 

7.1 Enter Data via the Event Capture Spreadsheet 

7.1.1 Before the User Starts 
• The Spreadsheet screen in the ECS GUI application allows users to open an existing file 

containing their workload data and upload it to the EVENT CAPTURE PATIENT file 
(#721). 

• The Spreadsheet application can work with existing Excel files and tab or comma delimited 
files.   Note:  All versions of Excel are compatiable with this functionality 

• Each record in the spreadsheet is validated before being filed in the EVENT CAPTURE 
PATIENT file (#721).  Two levels of validation occur.  The first level of validation occurs 
within Delphi. A check for necessary information is performed and no data transmits to 
VistA if the Delphi validation is not ‘passed’ for every record in the spreadsheet. After 
passing that level of validation, the RPC broker is “called” and each record transmits (one by 
one) to VistA for validation.  If an error occurs during this process, an error message displays 
and the record is not filed.  If an error does not occur, the record is filed in the EVENT 
CAPTURE PATIENT (#721) file.  This process occurs until all records have been validated. 
The records that are filed will be removed from the spreadsheet grid, leaving only those 
records with errors.  The error message(s) display in the error message box, and the records 
can be edited or deleted before retransmitting. 

 
7.1.2 What the User Will See 
Example: Spreadsheet Upload Screen 
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7.2 Entering Data via the Event Capture Spreadsheet Upload 
 
1. When starting the Spreadsheet Upload, the column headers display in a default order.  The 

user can change the order of the columns.  To do this, click on the Column Header button  
to change the order as needed. 

Note: To change column order, the user can select the Spreadsheet Options menu and click 
on “Change Column Headers” 

Note: Help is available for each column in the spreadsheet.  Click on any column and then 
click on the Help button . 

2. If an error message displays in the error message box, click on the error message to highlight 
the cell in the grid that most likely caused the error. 

3. If more than one provider exists with that name in the spreadsheet (or if there is a partial 
name match), the application will return matching and partial-matching provider information 
(provider name, IEN, specialty, subspecialty, person class) to the error box.  The desired 
provider can be determined and the user can enter the correct name or IEN information into 
the spreadsheet (as necessary).  

For example, provider name ECPROVIDER, ONE may return provider information for 
ECPROVIDER, ONE, ECPROVIDER, ONE A and ECPROVIDER, ONE B.  Provider name 
ECPROVIDER, THIRTY may return information for ECPROVIDER, THIRTY-ONE and 
ECPROVIDER, ONE HUNDRED THIRTY. 

4. It has been determined that some inpatient records may need to be uploaded.  We handle this 
by checking the patient status for that particular date/time.  If it is determined to be an 
inpatient record, then an ‘Inpatient Override’ checkbox appears on the screen, a warning 
message appears in the error message box, and the record returns for editing by the user.  At 
this point, the user has the following options. 

• Override the inpatient-warning message by selecting the Inpatient Override checkbox 
and then retransmit.  The record uploads as inpatient. 

• Change the Encounter date/time and upload it as outpatient. 

5. If the system detects duplicate records when the spreadsheet uploads, a ‘File Duplicate 
Record(s)’ checkbox appears on the screen.  The duplicate records display in the error 
message box.  If any duplicates exist when all of the records process, the prompt 'File 
Duplicate Record(s)' check box appears.  Selecting the check box and retransmitting files 
eliminates the duplicate records in EVENT CAPTURE PATIENT file (#721). 

6. Double-clicking on a cell in the spreadsheet grid and pressing <Delete> will remove only the 
contents of that cell only.  Clicking once on a cell and then pressing <Delete> will delete the 
ENTIRE RECORD. 
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7. Column Headers - When starting the spreadsheet upload program, the column headers 

display in a default order.  The user can change the column order at any time (before and after 
transmitting data to VistA).  To change the column header order, select ‘Spreadsheet 
Options’, ‘Change Column Headers’.  The default column header order is as follows: 

• Record number 
• Location 
• Pat SSN 
• Pat LName 
• Pat Fname 
• DSS Unit Name 
• DSS Unit Num 
• DSS Unit IEN 
• Proc Code 
• Volume 
• Ordering Sect 
• Prov Name or IEN 
• Enc Date/Time 
• Category 
• Diag Code 
• Assoc Clinic 

 
7.3 Spreadsheet Column Errors 
 
The following errors may display while uploading data into Event Capture via the Spreadsheet 
option: 
 

1. Record Number 

Each record in the spreadsheet needs a unique record number (during each 
transmission), i.e., 1, 2, 3, etc.  An error appears before VistA validation occurs if this 
field is blank.  If the record number is not unique and there are no errors for that 
record number on the VistA side during validation, then there is no problem, and the 
data will transmit successfully.  If the record number is not unique and an error has 
occurred on the VistA side, then the error messages is not properly mapped to the 
record(s) in error, and you will need to give it a unique record number at that point 
and retransmit the record(s) in error. 

 
Delphi messages 

Error getting column with Record number 
Record number is a mandatory field 
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2. Location 

The Location number must exist on the INSTITUTION file (#4, ^DIC(4,D0,0)). 
 

VistA message 
Location not on INSTITUTION file (#4) 

 
3. Pat SSN 

Patient SSN must exist on the PATIENT file (#2, ^DPT). 
If the SSN is shorter than 9 digits, it will be left filled with zeroes.  

 
VistA messages 

No SSN x-ref on PATIENT file (#2) 
No SSN entry on PATIENT file (#2) 
No internal entry on PATIENT file (#2) for SSN x-ref 
SSN does not match SSN on PATIENT file (#2) 

 
d. Patient LName and Patient FName 

Patient last and first name - The patient’s name (last name, first name) must match the 
name on the PATIENT file (#2) for that SSN. 

 
Delphi messages 

Error getting column with Patient LName 
Patient LName must be at least 2 characters long 

 
VistA messages 

Patient last name does not match VistA 
Patient first name does not match VistA 

 
e. DSS Unit Name 

If this field contains a value, then it must have a “B” cross-reference on the DSS 
UNIT file (#724). 
Note:  The DSS Unit name is not required if the DSS Unit IEN or the DSS Number 
column is filled in. 

 
VistA message 

Invalid DSS Unit Name 
 

f. DSS Unit Number 
This is the Unit Number, found on the DSS UNIT file (#724). If this field contains a 
value, then it must have a “C” cross-reference on the DSS UNIT file (#724).  
Note:  The DSS Unit Number is not required if the DSS Unit IEN or the DSS Unit 
Name is filled in. 

 



 Spreadsheet  
 

June 2012 Event Capture V. 2.0 GUI User Manual 59 
                                                                            Patch EC*2.0*112 
 

 
VistA message 

Invalid DSS Unit Number 
 

g. DSS Unit IEN 
If this field contains a value, then it must exist on the DSS UNIT file (#724). 
Note:  The DSS Unit IEN is not required if the DSS Unit Name or the DCM Dept is 
filled in. 

 
VistA message 

Invalid DSS Unit IEN 
 

h. Proc Code 
This is the procedure/CPT code value (not the description). The National Procedure, 
Local Procedure and CPT code are all valid codes for this column. The 
procedure/CPT must exist on the EC NATIONAL PROCEDURE file (#725) or the 
CPT file (#81), and the EC Event Code Screen must be ‘active’ for the Location, DSS 
Unit IEN, and Procedure/CPT combination. With functionality put in place by the 
Code Set Versioning project, only CPT codes that are active for the date and time of 
the event are processed. 

 
VistA messages 

Procedure or “D” x-ref not on EC NATIONAL PROCEDURE file (#725) 
Procedure invalid for this Location and DSS Unit 
Unable to check for active EC Event Code Screen 

 
i. Volume 

The volume must be a number from 1 through 99. 
 
Delphi error messages 

Error getting column with Volume number 
Volume is a mandatory field 
Volume has a limit of 2 digits 

 
VistA messages 

Volume must be a number from 1 to 99 
Volume must contain numeric characters only 

 
j. Ordering Section 

This is the name of the Ordering Section. A validation occurs for ordering sections 
entered into the spreadsheet by the user (against the “B” cross reference in the 
MEDICAL SPECIALTY file (#723)).  If the user leaves this field blank, the program 
will derive the Ordering Section from DSS UNIT file (#724) using the DSS Unit IEN. 
It will then transmit to the Event Capture filer program. 
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VistA message 

Invalid Ordering Section 
Unable to determine Ordering Section 

 
k. Prov Name or IEN 

This is the Provider’s last and first name as it appears in the “B” cross reference of the 
NEW PERSON file (#200).  If the provider also has a middle initial, then it should be 
included, i.e. ‘ECPROVIDER, SEVEN J’.  If the system finds a partial match for 
name, the application will return the provider information (provider name, IEN, 
specialty, subspecialty, person class) for all options to the error box, and you can then 
determine which provider they want.  The Provider must have a “B” cross-reference 
and exist on the NEW PERSON file (#200) and the person class must be ‘active’. 

 
LASTNAME, FIRSTNAME, or IEN 

 
VistA messages 

Provider has no B x-ref on NEW PERSON file (#200) 
Unable to determine person class 
Provider does not have an active person class 

 
l. Enc Date/Time 

The Encounter Date/Time can be in any valid FileMan format.  The ‘seconds’ are 
optional. 

 
Examples: 

mm/dd/yy @hh:mm:ss 
mm/dd/yyyy @hh:mm:ss 
mm-dd-yy @hh:mm 
mmddyy @hhmm 
N, N-1, N-1H, etc.  

 
VistA message 

Invalid encounter date/time 
 

m. Category 
The Category field can be blank. If the user enters a value, it needs to have a B cross-
reference in the EC CATEGORY file (#726). 

 
VistA message 

Category "B" x-ref not on EC CATEGORY file (#726) 
 
 
 
 



 Spreadsheet  
 

June 2012 Event Capture V. 2.0 GUI User Manual 61 
                                                                            Patch EC*2.0*112 
 

n. Diag Code 
This is the primary diagnosis code value.  It must exist on the ICD DIAGNOSIS file 
(#80).  With functionality put in place by the Code Set Versioning project, only ICD 
codes that are active for the date and time of the event process. 
Note:  The Diagnosis Code is only required for records sent to PCE.  The system 
ignores it otherwise. 

 
VistA messages 

Diagnosis code is required for this DSS Unit 
Unable to retrieve Diagnosis IEN 
Diagnosis code is required for this DSS Unit 
Unable to retrieve Diagnosis IEN 

 
o. Assoc Clinic 

This is the Associated Clinic name. It must have a “B” cross-reference on the 
HOSPITAL LOCATION file (#44), be of type “C” (clinic), and be ‘active’ for that 
encounter date.  The Associated Clinic must have conforming stop codes to be 
selectable. 
Note:  The Associated Clinic is only required for records sent to PCE and will be 
ignored otherwise. 

 
VistA messages 

Associated Clinic is required for this DSS Unit 
Assoc Clin "B" x-ref not found on HOSPITAL LOCATION file (#44) 
Assoc Clin not found on HOSPITAL LOCATION file (#44) 
Associated Clinic must be of type "C" (clinic) 
Associated Clinic inactive for this encounter date 

 
7.4 Other Logic 

 
DSS Unit IEN 
The system obtains DSS Unit IEN by checking the DSS Unit IEN field, the DCM Dept field 
and the DSS Unit Name field (only one is needed).  If any of the three columns contain 
erroneous data, an error message displays and the record does not file. 
 
Send to PCE 
Using the DSS Unit, the application determines if the record transmits to PCE. If so, the 
application then validates the Associated Clinic and Diagnosis Code.  If not, the system 
ignores these two columns. 
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7.5 Example of Uploading Data via Event Capture 
Spreadsheet 

 
1. Click on the Spreadsheet button in the Main Menu.  

Note:  This functionality is compatiable with all versions of Excel. 

2. Click Open in the File menu to display a list of Excel files from which to choose. 
Find Excel file and click Open.  A list of patient data will appear with column 
headings for Record Number, Station Number, Patient first and last name, SSN, DSS 
Unit Number and IEN, DCM Department, Procedure and Diagnosis Code, Volume, 
Service, Provider first and last name, Encounter Date/Time, and Associated Clinic. 

Example:  Selecting a File to Upload Prior to Excel 2007 

 

Example: Selecting a File to Upload for Excel 2007 or Newer 
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Example: Sample Data for Spreadsheet Upload 

 
 

Note:  The user can change the spreadsheet column order. 
 

3. To change the spreadsheet with a different order, click on the Column Header button 
 or select the Spreadsheet Options menu and click on Change Column Headers 

to change the order. 
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 Example: Change Column Headers Pop-up 

 
 
4. To change the order of the columns, highlight the column heading in the list and 

clicking on the Move Up and Move Down buttons.  Continue to change the column 
heading order until it matches the spreadsheet used and then upload the spreadsheet. 

Note: At this point, the user can change the Duplicate Threshold value through the 
Spreadsheet Options dropdown menu by selecting Change Duplicate Threshold. 
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Example:  Changing Duplicate Threshold 

 
 
5. Click on Transmit EC Data to VistA in the EC Transmission menu or the Update 

Records to VistA button  in the toolbar.  The data is validated and uploaded and 
error messages display for those records containing errors.  

6. The Spreadsheet checks for duplicate records, based on the Location (Station 
number), Patient SSN, DSS Unit, and Procedure Date/Time. The duplicate records 
display below the spreadsheet.  When the user-defined threshold of duplicate records 
is reached, a message box will display with the options of Continue, Change and 
Abort. 

Example:  Duplicate Records Threshold Reached Screen 
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• Continue                  : resets the counter and resumes processing of records. 

• Change                    : The Duplicate Threshold defaults 10 to a user-defined 
number. The Duplicate Threshold value can be changed two ways: 

 From the Spreadsheet Options dropdown menu, select Change Duplicate 
Threshold  

 When the threshold is reached and the Duplicate Record Threshold Reached 
window is displayed, click the Change button 

• Abort                   : terminates the upload process. 
 
Example: Aborting Process Pop-up 

 
 

7. The user can correct/delete records with errors and the spreadsheet retransmitted.  

                  Example: Sample Data with Error Messages Before Upload 

 
 

8. When the data transmits, only those records with errors will return.  
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Example:  Errors Remaining After Data Transmits 

 
 

9. Any records filed into the EVENT CAPTURE PATIENT file (#721) will not appear 
in the spreadsheet grid after transmission.  A message will appear in the status bar at 
the bottom of the screen with a count of successfully transmitted records and a count 
of how many error messages there are. 

Example:  Spreadsheet Showing Successfully Transmitted Records 
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8 Reports 
 
8.1 Available Reports 
 
The user can preview and/or print the reports listed below.  Five reports (Procedure Reasons 
Report, DSS Unit Users Access Report, Event Capture Encounters Report, Event Code Screens 
with Inactive Default Associated Clinic and DSS Units/Event Code (EC) Screens for Selected 
Procedure Code Report) can be exported into Excel. 
 
The following reports are available: 
 
• Patient Summary Report 
• DSS Unit Activity Report 
• DSS Unit Workload Report 
• Provider Summary Report 
• Ordering Section Summary Report 
• Provider (1-7) Summary Report 
• PCE Data Summary Report 
• Inactive Person Class Report 
• Procedure Reasons Report 
• ECS Records Failing Transmission to PCE Report 
• DSS Unit Users Access Report 
• National / Local Procedure Report 
• Category Report 
• Print Category and Procedure Summary (Report) 
• Event Code Screens with CPT Codes Report 
• National / Local Procedure Codes with Inactive CPT Codes  
• DSS Units with any Associated Stop Code Errors  
• Event Capture Encounters Report 
• Event Code Screens with Inactive Default Associated Clinic 
• DSS Units/Event Code (EC) Screens for Selected Procedure Code Report 
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8.2 Patient Summary Report 
 
• The design of this report is for a 132-column format. 
• With functionality put in place by the Code Set Versioning project, CPT codes, five-character 

EC National Codes (when applicable), CPT modifiers and their associated descriptions are 
reflective of the date the event occurred.  

• The user can choose to include Procedure Reasons (EVENT CAPTURE PATIENT file 
(#721)) on the report.  Up to three reasons will be included. 

• The “Display Reasons on this report” will clear when the user selects another report or upon 
exiting the screen. 

• After previewing the report, the user will have the option to print or cancel the report. 
 
Instructions 

1. Enter a date range. 
2. Use the Patient Identifier field to select a patient. 

• Enter one of the following: 
 Patient Name (whole or partial, last name first) 
 Social Security Number 
 Last four digits of the Patient Social Security Number 
 First character of Last Name plus the last four digits of the SSN with no spaces 

• Press <Enter> or the Search button.  
• Choose from the list of patients displayed. 

3. Choose whether to include Procedure Reasons in the report. 
4. Preview                , Print                  or Cancel                 the report. 
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Example:  Patient Summary Report Required Information without Reasons 

 
 
Example: Patient Summary Report from Report Preview without Reasons 
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Example:  Patient Summary Report Required Information with Reasons checked 

 
 
Example: Patient Summary Report from Report Preview with Reasons 
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8.3 DSS Unit Activity Report 

 
• The report can be sorted by patient, provider or SSN 
• If more than one location has been set up, choose one or all locations. 
• After previewing the report, the user has the option to print or cancel the report. 
 
Instructions 

1. Enter a date range. 
2. Select one or all Location(s). 
3. Select one or all DSS Unit(s). 
4. Choose Sort Method (Patient, Provider or SSN) for the report. 

Note:  Only the last four digits of the patient’s SSN will appear on this report. 
5. Preview                , Print                  or Cancel                 the report. 

 
Example: DSS Unit Activity Report Required Information 
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Example:  DSS Unit Activity Report from Print Preview 
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8.4 DSS Unit Workload Report 
 
• With functionality put in place by the Code Set Versioning project, CPT codes, five-character 

EC National Codes (when applicable), CPT modifiers and their associated descriptions are 
reflective of the date the event occurred 

• After previewing the report, the user has the option to print or cancel the report. 
 

Instructions 
1. Enter a date range. 
2. Select one or all location(s). 
3. Select one or all DSS Unit (s). 
4. Preview                , Print                  or Cancel                 the report. 

 
Example:  Required Information for DSS Unit Workload Report 
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Example:  DSS Unit Workload Report from Print Preview 
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8.5 Provider Summary Report 
 
• Locations, DSS Units, categories, procedures and procedure reasons must be defined before 

generating this report. 
• If Procedure Reason #1 is not listed, the report prints “Reason Not Defined”. 
• With functionality put in place by the Code Set Versioning project, CPT codes, five-character 

EC National Codes (when applicable), CPT modifiers and their associated descriptions are 
reflective of the date the event occurred. 

• After previewing the report, the user has the option to print or cancel the report. 
 
Instructions 

1. Enter a date range. 
2. Select one or all Location(s). 
3. Select one or all DSS Unit(s).  
4. Preview                , Print                  or Cancel                 the report. 

 
Example:  Provider Summary Report Required Information 
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Example:  Provider Summary Report from Print Preview 
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8.6 Ordering Section Summary Report 
 
• The design of this report is for a 132-column format. 
• With functionality put in place by the Code Set Versioning project, CPT codes, five-character 

EC National Codes (when applicable), CPT modifiers and their associated descriptions are 
reflective of the date the event occurred. 

• After previewing the report, the user has the option to print or cancel the report. 
  
Instructions 

1. Enter a date range. 
2. Select an Ordering Section. 
3. Select a specific or all Location(s). 
4. Select one, multiple or all DSS Unit(s). 
5. Preview                , Print                  or Cancel                 the report. 

 
Example:  Ordering Section Summary Report Required Information 
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Example:  Ordering Section Summary Report from Print Preview 
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8.7 Provider (1-7) Summary Report 
 
• The design of this report is for a 132-column format. 
• With functionality put in place by the Code Set Versioning project, CPT codes, five-character 

EC National Codes (when applicable), CPT modifiers and their associated descriptions are 
reflective of the date the event occurred. 

• This report provides the ability to view up to seven provider numbers for providers within a 
Location/DSS Unit. 

• Summarizes the workload of providers for a selected date showing how many times a 
specific procedure was performed on a patient with the selected provider as Provider 1, 
Provider 2, through Provider 7. 

• After previewing the report, the user has the option to print or cancel the report. 
 

Instructions 
1. Enter a date range. 
2. Enter the name of a Provider. 
3. Preview                , Print                  or Cancel                 the report. 
 

Example:  Provider (1-7) Summary Report Required Information 
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Example: Provider (1-7) Summary Report from Print Preview 
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8.8 PCE Data Summary Report 
 
• The design of this report is for a 132-column format. 
• With functionality put in place by the Code Set Versioning project, CPT codes, five-character 

EC National Codes (when applicable), CPT modifiers, diagnosis codes and their associated 
descriptions are reflective of the date the event occurred.  

• After previewing the report, the user has the option to print or cancel the report. 
 
Instructions 

1. Enter a date range. 
2. Use the Patient Identifier field to select a patient. 

• Enter one of the following: 
 Patient Name (whole or partial, last name first) 
 Social Security Number 
 Last four digits of the Patient Social Security Number 
 First character of Last Name plus the last four digits of the SSN with no spaces 

• Press <Enter> or the Search button.  
• Choose from the list of patients displayed. 

3. Preview                , Print                  or Cancel                 the report. 
 
Example: PCE Data Summary Report Required Information 
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Example:  PCE Data Summary Report from Print Preview 
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8.9 Inactive Person Class Report 
 
• This report shows providers who do not have a Person Class specified in the NEW PERSON 

file (#200) or who does not have an active Person Class in the NEW PERSON file (#200) for 
the date of the procedure. 

• After previewing the report, the user has the option to print or cancel the report. 
 
Instructions 

1. Enter a date range. 
2. Select Sort by Patient or Sort by Procedure. 
3. Preview                , Print                  or Cancel                 the report. 

 
Example: Inactive Person Class Report Required Information 
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Example:  Inactive Person Class Report from Print Preview 
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8.10 Procedure Reasons Report 
 
• Locations, DSS Units, procedures, and procedure reasons must be defined before using this 

option. 
• With functionality put in place by the Code Set Versioning project, CPT codes, five-character 

EC National Codes (when applicable), CPT modifiers, diagnosis codes and their associated 
descriptions are reflective of the date the event occurred. 

• After previewing the report, the user has the option to print or cancel the report. 
• This report is exportable into an Excel spreadsheet.  The tab in Excel is titled “Reasons” 

followed by the Date Range the user selected.  The columns on the spreadsheet will include 
Location, DSS Unit, Reason Text, Reason Number, Procedure Code, SSN (last 4 digits), 
Patient, Date/Time and Provider. 

 
Instructions 

1. Select a date range. 
2. Select one, all or multiple Location(s). 
3. Select one, all or multiple Procedure Reasons. 
4. Select one, all or multiple DSS Unit(s). 
5. Export                  , Preview                , Print                  or Cancel                 the report. 
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Example:  Procedure Reasons Report from Print Preview 

 
 

Example:  Procedure Reasons Report from Export 
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8.11 ECS Records Failing Transmission to PCE Report 
 
• Locations, DSS Units, procedures, five-character EC National Codes (when applicable) and 

categories must be defined before using this option. 
• After previewing the report, the user has the option to print or cancel the report. 
 
Instructions 

1. Select the date Range. 
2. Preview                , Print                  or Cancel                 the report. 

 
Example: ECS Records Failing Transmission to PCE Report Required Fields 
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Example:  ECS Records Failing Transmission to PCE Report from Print Preview 

 
 

 



Reports – DSS Unit User Access Report  
  

June 2012 Event Capture V. 2.0 GUI User Manual 91 
                                                                            Patch EC*2.0*112 
 

8.12 DSS Unit User Access Report 
 
• This report is also accessible from the Grant Users Access menu option. 
• After previewing the report, the user has the option to print or cancel the report. 
• This report is now exportable into an Excel spreadsheet.  The tab in Excel is titled “DSS Unit 

User Access Report”.  The columns on the spreadsheet will include DSS Unit, User Name, 
IEN and Person Class/Classification. 

 
Instructions: 

1. Select a Location. 
2. Select one, all or multiple DSS Units. 
3. Export                  , Preview                , Print                  or Cancel                 the report. 

 
Example:  DSS Unit User Access Report Required Fields 
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Example:  DSS Unit User Access Report from Print Preview 

 
 
Example:  DSS Unit User Access Report from Export 
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8.13 National/Local Procedure Report 
 
• Use the Procedure - Add or Update Local Procedures option to create local procedures 

before using this option. 
• This report is accessible to Management users only.  For users without the Management 

Security key (ECMGR), this report will not appear.  
• After previewing the report, the user has the option to print or cancel the report. 
 
8.13.1 Instructions - Active Procedures 

1. Click the Active button. 
2. Choose Preferred Report (National, Local or Both). 
3. Choose the Sort Method (Procedure or National Code). 
4. Preview                , Print                  or Cancel                 the report. 

 
Example:  National/Local Procedure Report (Active) Requirements 
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Example:  Nation/Local Procedure Report (Active) from Print Preview  
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8.13.2 Instructions - Inactive Procedures 
1. Click the Inactive button. 
2. Preview                , Print                  or Cancel                 the report. 

Note: If the report is marked as Inactive, the preferred report and sort method will be 
grayed out.  

 
Example:  National/Local Procedure Report (Inactive) Required Fields 
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Example:  National/Local Procedure Report (Inactive) from Print Preview 
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8.14 Category Report 
 
• Use the Category - Add or Update Categories option to create categories before using this 

option. 
• This report is accessible to Management users only.  This report will not appear for users 

without the management security key (ECMGR). 
• After previewing the report, the user has the option to print or cancel the report. 
 
Instructions 

1. Choose a status of Active, Inactive or Both. 
2. Preview                , Print                  or Cancel                 the report. 
 

Example:  Category Report Required Fields 
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Example – Category Report (Active) from Print Preview 

 
 
Example – Category Report (Inactive) from Print Preview 

 
 

Example – Category Report (Both Active and Inactive) from Print Preview 
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8.15 Print Category and Procedure Summary (Report) 
 
• Use the DSS Unit - Add or Update DSS Units option to create DSS Units categories before 

using this option. 
• Use the Category - Add or Update Categories option to create categories before using this 

option. 
• Use the Procedure - Add or Update Local Procedures option to create procedures before 

using this option. 
• This report is accessible to Management users only.  This report will not appear for users 

without the management security key (ECMGR). 
• After previewing the report, the user has the option to print or cancel the report. 
 
Instructions 

1. Select one or all Location(s).  
2. Select one or all DSS Unit(s). 

Note: If All is selected for the DSS Unit, the Category will also be All and will be grayed 
out. 

3. Select a Category. 
Note: Categories only appears if the Event Code Screen uses categories to group 
procedures. 

4. Select Active, Inactive or Both (Active and Inactive) EC Code Screens. 
5. Preview                , Print                  or Cancel                 the report. 
 

Example:  Print Category and Procedure Summary (Report) Required Fields 
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Example: Print Category and Procedure Summary (Report) from Print Preview 
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8.16 Event Code Screens with CPT Codes Report 
 
• This option allows the user to print/display Event Code screens with active/inactive/both 

CPT codes for all or a specific DSS Unit.  Inactive CPT codes are flagged with an *I* when 
printing both active and inactive codes  

• Users must have the ECMGR key to access this report. 
• After previewing the report, the user has the option to print or cancel the report. 
 
Instructions 

1. Select one or all Location(s).  
2. Select one or all DSS Unit(s). 

Note: If All is selected for the DSS Unit, the Category will also be All and will be grayed 
out. 

3. Select a Category. 
Note: Categories only appears if the Event Code Screen uses categories to group 
procedures. 

4. Select Active, Inactive or Both (Active and Inactive) EC Code Screens. 
5. Preview                , Print                  or Cancel                 the report. 

 
Example:  Event Code Screens with CPT Codes Report Required Fields 
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Example: Event Code Screens with CPT Codes Report from Print Preview 
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8.17 National/Local Procedure Codes with Inactive CPT 
Codes  

 
• This report provides a list of National and Local Procedure Codes with inactive CPT codes 

from EC NATIONAL PROCEDURE file (#725). 
• Users must have the ECMGR key to access this report. 
• After previewing the report, the user has the option to print or cancel the report. 
 
Instructions 

1. Select the report.  
2. Preview                , Print                  or Cancel                the report. 

 
Example:  National/Local Procedure Codes with Inactive CPT Codes 
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Example:  National/Local Procedure Codes with Inactive CPT Codes from Print Preview 
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8.18 DSS Units with any Associated Stop Code Errors 
 
• The Event Capture software restricts DSS-only workload to use valid Stop Codes.  
• To assist sites in locating DSS Units that have invalid associated Stop Codes, the DSS Unit 

list with Secondary Associated Stop Codes option is provided.  This may be attached as a 
secondary menu option and run as often as needed. The only prompt is for Device.  

• This report provides a list of DSS Units with any error with the Associated Stop Code. 
• The report provides the DSS Unit IEN and name, Associated Stop Code IEN and name and 

the reason for the error. 
• After previewing the report, the user has the option to print or cancel the report. 
• Select an active non-secondary Stop Code to replace the Stop Code in the DSS Unit set up. 
 
Instructions 

1. Select the report.  
2. Preview                , Print                 or Cancel                 the report. 

 
Example:  DSS Units with Any Associated Stop Code Errors Required Fields 
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Example: DSS Units with any Associated Stop Code Errors 
 
-------------------------------------------------------------------- 
DSS UNITS WITH ANY ASSOCIATED STOP CODE ERRORS 
Page: 1                                              Run Date: 11/3/2011@14:25 
------------------------------------------------------------------------------- 
 
DSS Unit:     21      E-PUBLIC HEALTH NURSES-IP 
Stop Code:  122    PUBLIC HEALTH NURSING 
Reason: INACTIVE CODE 
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8.19 Event Capture Encounters Report 
 
• Displays and counts the unique occurrences by patient and DSS Unit during a selected date 

range. It also allows sorting by patient or by provider. 
 When sorted by Patient shows the number of unique occurrences for the Patient across 

the date range that is selected.  
 When sorted by Provider shows the number of unique occurrences for the Provider across 

the date range that is selected. 
•  Includes the fields Patient Name, SSN (last 4 digits), Inpatient or Outpatient (I/O), 

Date/Time, Provider #1, DSS Unit and Volume. 
• After previewing the report, the user has the option to print or cancel the report. 
• This report is now exportable into an Excel spreadsheet.  The tab in Excel is titled 

“Encounter” followed by the Date Range the user selected.  The columns on the spreadsheet 
will include Location, Patient, SSN (last 4 digits), I/O, Date/Time, Provider #1, DSS Unit and 
Volume. 

 
Instructions: 

1. Select a date range. 
2. Select a Location. 
3. Select one, all or multiple DSS Unit(s). 
4. Select Sort Method (Patient or Provider). 
5. Export                  , Preview                , Print                  or Cancel                 the report. 

 
Example: Event Capture Encounters Report Required Fields 
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Example:  Event Capture Encounters Report Sorted by Patient from Print Preview 

 
 
Example: Event Capture Encounters Report Sorted by Provider from Print Preview 
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Example: Event Capture Encounters Report from Export 
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8.20 Event Code Screens with Inactive Default Associated 

Clinic 
 
• Only holders of the ECMGR security key can run this report. 
• After previewing the report, the user has the option to print or cancel the report. 
• This report is now exportable into an Excel spreadsheet.  The tab in Excel is titled “Inactive 

Default Clinic”.  The columns on the spreadsheet will include DSS Unit, Location, Category, 
Procedure Code, Inactive Clinic IEN and Inactive Clinic Name. 

• The fields DSS Units, Location, Category, Procedure Code, Clinic IEN and Clinic Name are 
included in this report. 

 
Instructions: 

1. Select one, all or multiple Location(s). 
2. Select one, all or multiple DSS Unit(s). 
3. Export                  , Preview                , Print                  or Cancel                 the report. 

 
Example:  Event Code Screens with Inactive Default Associated Clinic 
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Example:  Event Code Screens with Inactive Default Associated Clinic from Print Preview 

 
 

Example: Event Code Screens with Inactive Default Associated Clinic from Export 
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8.21 DSS Units/Event Code (EC) Screens for Selected 
Procedure Code Report 

 
• Only holders of the ECMGR security key can run this report. 
• After previewing the report, the user has the option to print or cancel the report. 
• This report is now exportable into an Excel spreadsheet.  The tab in Excel is titled “Selected 

Procedure Code”.  The columns on the spreadsheet will include Procedure Code, Procedure 
Name, DSS Unit IEN, DSS Unit, Location, Category and EC Screen Status. 

• The fields DSS IEN, DSS Unit Name, Location, Category and EC Screen Status are included 
in this report. 

 
Instructions: 

1. Select one, all or multiple Location(s). 
2. Select a Procedure. 
3. Export                  , Preview                , Print                  or Cancel                 the report. 

 
 
Example:  DSS Units/Event Code (EC) Screens for Selected Procedure Code Report 

Required Fields 
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Example:  DSS Units/Event Code (EC) Screens for Selected Procedure Code Report from 
Print Preview 

 
 
Example:  DSS Units/Event Code (EC) Screens for Selected Procedure Code Report from 

Export 
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9 Management Menu 
 
The DSS Management Menu is available for users with the ECMGR security key.  The main 
menu in the Management Menu provides the following management functions: 
 
Location – Update Location Information 
DSS Unit – Add or Update DSS Units 
Access by User – Grant Access to DSS Units by User 
Category – Add or Update Categories 
Procedure – Add or Update Local Procedures 
Event Code Screen – Add or Update Event Code Screens 
Inactivate EC Screen – Identify/Inactivate Multiple Event Code Screens 
 
Example: Event Capture Management Main Menu 
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9.1 Location - Update Location Information 
 
Before the User Starts 
 
• Location selected must be in the INSTITUTION file (#4). 
• Locations must be created with this option before the user can establish DSS Units.  No 

further options are functional until the user creates an Event Capture location. 
 
What the User Will See 
 
• Selecting the Location - Update Location Information option opens a screen that displays all 

the known location names, State, Facility Type, Station Number and Current Status in matrix 
form. Column size of the matrix is adjustable. 

• From the first screen double-click on a row or highlight a row and click the Update  
button. 

 
Example: Management Menu [Locations] Screen 

 
 
After selecting a location, a second screen will appear where you may create the location as 
current or remove the selected location.  
 
Example: Edit Location Screen 
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The rows can be sorted by using the Sort menu or by clicking on the column header. 
 
Example: Sort Menu Options 

 
 
To create a current location, click the checkbox labeled “Create as current Event Capture 
location” and click the OK button.  The location is “flagged” as active for use in the Event 
Capture software.  
 
Example: Creating a Current Location 
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To remove a current location, click the checkbox labeled “Remove as current Event Capture 
location” and click the OK button.  The location is “flagged” as inactive for use in the Event 
Capture software. 
 
Example:  Removing a Current Location  
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Select the Export                   button to export the Locations listing to Excel and the tab in Excel 
is titled “ECS Location Table Export”. 
 
Example:  ECS Location Table Export from Excel 
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9.2 DSS Unit - Add or Update DSS Units 
 
Before the User Starts 
 
• Use the Location - Update Location Information option to create an Event Capture location 

before using this option.  
• A prompt displays a notification to enter an Associated Stop Code only if the "Send to PCE" 

flag is set to NO or NULL. 
• No further options are functional until DSS Units are created. 
 
What the User Will See 
 
• After selecting DSS Unit from the Management Menu, the first screen will display a list of 

DSS Units.  Click the Update                  button to update an existing DSS Unit or click the 
Add                 button to add a new DSS Unit. 

 
Example:  DSS Units Screen on Management Menu 

 
 
Select Active, Inactive or All DSS Units. 
 
The DSS Units screen contains the following columns: 

• Unit IEN 
• Active Status for DSS Unit (Yes or No)  
• The PCE column reflects if workload is set to pass to PCE. Values include:   
 ALL – Send all records 
 Outpatient – Send outpatient only 
 No – Send no records. 

• DSS Department 
• Service 
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• Medical Specialty 
• Cost Center 
 

Using the Find       button, the user can search by DSS Unit, DSS Dept. and Unit IEN. Type in a 
partial search string, press find and the screen will position to the first entry matching your search 
criteria. 
 
The Print                 button allows users to print the report.  
 
The Export                 button allows users to export the data to an Excel spreadsheet. 
 
Example: Report Exported into Excel 

 
 
Click Update                  to update an existing DSS Unit or click Add                to add new one.  
The “Edit a DSS Unit” or “Add a DSS Unit” screen will appear. 
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Example:  Edit a DSS Unit Screen 

 
 
Below are the element name and description for each field that appear on the Add or Edit DSS 
Unit screen:  
 

Element Name Description 
DSS Unit Name The name of the DSS Unit being created 
DSS Dept and IEN The number to identify this DSS unit locally at the user’s site (1 

to 14 characters) - The same DSS Unit number can be used for 
more than one DSS Unit  

Service The service associated with this DSS Unit - from the 
SERVICE/SECTION file (#49) 

Medical Specialty The medical specialty associated with this DSS Unit - from the 
MEDICAL SPECIALTY file (#723) 

Cost Center The cost center associated with this DSS Unit - from the COST 
CENTER file (#420.1). Cost centers are defined in MP4-Part V, 
Appendix B of the Fiscal Service cost manuals. 

Default Date/Time NOW – The current date and time will populate during data entry 
NONE – The date and time will not be filled in during data entry. 
The user will be required to enter it. 

Allow Category Use (Y/N) YES – Use categories to group procedures during data entry 
NO – Do not use categories to group procedures during data 
entry 
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Element Name Description 
DSS Unit Status Active -     Lists Active Event Code Screens 

Inactive -   Lists Inactive Event Code Screens 
Event Code Screens Reactivate 

Remain Inactive 
Send to PCE Defines the method used to send the user’s data to PCE for the 

DSS Unit the user is creating. 
All Records              Send All Records 
Outpatient Only       Send Outpatient Only 
No Records              Send No Records 

Associated Stop Code Select the DSS ID (Clinic Stop Code) associated with this DSS 
Unit. Be sure to select an active DSS ID.  

 
Note: on add or edit screens, the status defaults to “Active.” The Allow Category Use field 
defaults to “No”, but the user can select “Yes”.  The Send to PCE option can be setup for “No 
Records” and the Associated Stop Code field enables. A search for the Associated Stop Code can 
occur by description or code and both description and code display.  The Send to PCE option can 
be set to “All Record” or “Outpatient Only” and the Associated Stop Code field will be disabled. 
All other default options have the capability to be changed. 
 
Instructions to Add a DSS Unit: 
1. Click on the Add                 button.  
2. Enter a DSS Unit Name.  
3. Enter a DSS Unit Number.  
4. Select a Service from the list provided.  
5. Select a Medical Specialty from the list provided.  
6. Select a Cost Center from the list provided. 
7. Choose the Date/Time Default. 
8. Choose whether or not to Allow Category Use. 
9. Choose which records will be Sent to PCE. 
10. Click OK                 when selections are complete. 
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Instructions to Update a DSS Unit: 
1. Select a DSS Unit from the list of DSS Units and click on the Update                 button.  
2. A second screen will appear.  On this screen the DSS Unit Name, DSS Unit Number, 

Service, Medical Specialty, Default Date and Time, Allow Category Use, DSS Status, Event 
Code Screens status and Send to PCE options can be updated.  
Note:  DSS Status may be Active or Inactive. Note that the Event Code Screen Options are 
different when Inactive is chosen for DSS Status. 

Example: Original Active Status  Example: Original Inactive Status 

 
 

When the DSS Status is changed, the Event Code Screens options also change. 

Example: Change from Active to Inactive Change from Inactive to Active 

 
     
If the user selects Retain, the DSS Unit will remain active.   If the user selects Inactivate, the 
DSS Unit that was active will be inactivated.  Once a DSS Unit is inactive, the user can activate 
the DSS Unit again by selecting Reactivate.   If the user selects Remain Inactive, the DSS Unit 
will remain inactive. 

3. Click OK                 when selections are complete. 

 
Granting Access to DSS Unit 
From the Add or Update DSS Units screens, the user has the option to give specific users access 
to the DSS Units selected.  

1. Click on the Access                   button at the bottom of the Add or Update DSS Units 
screens.  

2. The Grant Access to DSS Unit Screen has Include                    and Exclude                 
fields. 

3. There is a search field that allows the user to key in beginning characters of the last name 
above Include.  Scroll through the list to search for a last name.  The Exclude field 
contains the set up for all active users in VistA at the site. 

4. To give or take away access to a specific DSS unit, the management user must move the 
user’s names from the Included and Excluded boxes by highlighting the name and 
pressing the Include or Exclude button.  The name will move into the desired box. 
Note:  The IEN and Person Class/Classification for each user appear below both 
Excluded and Included lists. 
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Example: Grant Access to DSS Unit Screen 

 
Note:  Information has been deleted intentionally to preserve privacy 
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9.3 Access by User - Grant Access to DSS Units by User 
 
Before the User Starts 
 
• Note:  Use extreme caution when utilizing this option.  Removing access to a specified DSS 

Unit for all users and inactivating the DSS Unit is not recommended without the permission 
of the associated service.  

• Contact each service for a list of its Event Capture users and the DSS Units for which they 
enter data. 

• The user must have access to DSS Units before you can begin entering procedure data. 
• Access can be provided to all DSS Units by assigning the ECALLU security key to a 

specified user (normally the DSS Manager or designee) using the Allocation of Security Keys 
option in the Key Management Menu under the Menu Management Menu.  
Note: This option cannot be used to remove access to DSS Units for users who hold the 
ECALLU security key. 

 
Instructions to Assign User Access to DSS Units 

1. Click on the Access by User - Grant Access to DSS Units by User button.  
2. When the screen opens, a list of users appears at the top of the box.  Select a user. 
 

Example: Grant Access to DSS Units by User  
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3. Select the names of the DSS Unit(s) by highlighting the particular unit and clicking on the 
Include                   button.  

 
Example:  Including DSS Units 

 
 

4. Click the Apply                 button to apply the changes and continue working or click    
OK                  button to apply the changes the exit the screen. 

5. The user can print a list of users identified as having access to a given DSS Unit by 
selecting the Print                  button. 
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9.4 Category - Add or Update Categories 
 
Before the User Starts 
 
• The user can ignore this option if the site’s DSS Units are defined for use without categories. 
• Categories cannot be deleted but this option can be used to inactivate or reactivate them. 
 
What the User Will See 
 
• After selecting Category – Add or Update Categories from the Management Menu, the first 

window displays a list of Category Names, the Date created, and the Inactivation Date. 
 
Example: Categories Main Screen on Management Menu 

 
 
• The second screen allows the user to add a Category or to update a selected Category.  The 

second screen contains fields called Category Name and Status. 
 
Instructions to Add or Update Categories 
1. To add a new local category: 

• Click Add                  on the toolbar or in the Edit menu.  The Status field defaults to 
“Active”. 

Example: Edit Menu 
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• Enter the new local category name. 
 
Example: Add Category 

 
 

• Click OK. 
 
2. To update an existing local category: 

• Click on the Category to activate status field.  
Note: The Status field displays the current status is for the Category.  

• Change the category to its new status by clicking Active or Inactive.  The results of this 
action will appear on the first screen. 
 

Example: Update Category 

 
 
• Click OK. 

 
3. The Categories screen on the Management Menu will reflect the changes made. 

4. The Export                 button allows users to export the data to an Excel spreadsheet. 
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Example: ECS Category Table Exported from Excel 
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9.5 Procedure - Add or Update Local Procedures 
 
Before the User Starts 
 
• Before using this option, you might want to use the National/Local Procedure Report option 

on the Reports menu of the Event Capture Main Menu to print a list of procedures with their 
associated CPT codes.  This report can be lengthy if it includes national procedures.  This 
should be queued to print to a device during non-peak hours. 

• You must enter an associated CPT code to pass local procedures to the PCE software. 
• A local procedure code number is required for any new local procedure.  
• The local number code must be five characters in length, starting with an uppercase alpha 

character, followed by four alpha or numeric characters. 
• With functionality put in place by the Code Set Versioning project, only active CPT codes are 

made available, and are based on the date a local procedure is added. 
 
What the User Will See 
 
• After selecting Procedure - Add or Update Local Procedures from the Management Menu, 

the first screen displays a list of Local Procedure Names, Procedure Number, CPT Code, and 
CPT Description and Active Status. 

 
Example:  Procedures Main Screen on Management Menu 

 
 
 
 
 
 
 



Management Menu – Procedure 
  

June 2012 Event Capture V. 2.0 GUI User Manual 131 
                                                                            Patch EC*2.0*112 
 

• The second screen allows the user to add a Local Procedure or update a selected Local 
Procedure. The second screen contains the following fields:  Procedure Name, Procedure 
Number, CPT Code and Description and Status.  
 
Example: Add Local Procedure 

 
 
• Procedures cannot be deleted but this option can be used to inactivate or reactivate them. 
• The CPT Code and Description field contains CPT Code look-up functionality.  This makes a 

CPT Code searchable by the code, a part of the code, or a part of the description.  
• The option to print a  list of the user’s current local procedures can be chosen. 
• When adding a Local Procedure Code, the system checks it against the National Procedure 

code format to prevent a Local Code that is already assigned as a National Code from being 
added.  A message is displayed and the Local Code is prevented from being added. 

 
Instructions to Add or Update Local Procedures 
1. To add a new local procedure: 

• Click on the Add                 button in the Edit menu or on the toolbar. 

Example:  Edit Menu 

 
• Enter the new local Procedure Name. 
• Enter the local Procedure Number. 
• Enter the CPT Code if the data will transmit to the PCE software. 
• Click OK.  The new local procedure has been added. 
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Example: Adding a Local Procedure 

 
 
Example:  Update after Adding a Local Procedure 
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2. To update an existing local procedure: 
• Highlight the original local Procedure Name and double-click or click the Update   

button.  
• Edit the Procedure Name, Procedure Number, CPT and Description and/or Status. 
• Click OK.  The local procedure has been updated. 

 
Example: Editing a Local Procedure 

 
 
Example:  Update after Editing a Local Procedure 
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Select the Export                   button to export the Locations listing to Excel and the tab in Excel 
is titled “ECS Procedure Table Export”. 
 

Example: Export of Procedures into Excel 
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9.6 Event Code Screen - Add or Update Event Code Screens 
 
Before the User Starts 
 
• Use the Location - Update Location Information option to create an Event Capture location 

before using this option.  
• Use the DSS Unit - Add or Update DSS Units option to establish DSS Units before using this 

option. 
• Event Code screens must be defined before entering any Event Capture data. 
• A prompt for Category occurs only if the Event Code screen uses categories to group 

procedures. 
• The user must define an active Associated Clinic and CPT code to pass Event Code 

procedures to PCE.  
• With functionality put in place by the Code Set Versioning project, only active CPT codes 

can be selected and they will be based on the date the event code screen is being set up.  
• The Event Code screen allows the use of characters “/” and “-” in the search field. 
• The Associated Clinic on the Event Code screen is not auto-populated. 
• The Print and Export buttons have been added to the Event Code Screen. 
 
What the User Will See 
 
• After selecting Event Code Screen - Add or Update Event Code Screens from the 

Management Menu, the first screen displays a dropdown box of DSS Units with their 
corresponding Categories and Procedures and Locations.  

• Select a DSS Unit to display the Event Code Screen data. Columns include Synonym, 
Procedure, Location, Category and Status.  

 
Example: Event Code Screens Sample 
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• The Event Code Report can be printed.  When printing the report, the user will be prompted 
to choose Active, Inactive or All for the Clinic Status. 
 
Example: Select Clinic Status for the Report  

 

 
 

• The Event Code Table Report can also be exported to Excel.  The user will be prompted to 
choose Active, Inactive or All for the Clinic Status.  The Excel spreadsheet columns include 
in this report are Synonym, Procedure, Location, Default Associated Clinic, Category and 
Status.  The spreadsheet tab is “Event Code Table Export”. 
 
Example:  Exported Event Code Table Report 
 

 
 
• Highlight the Procedure and select Add                    or Update                   buttons.  The 

Update Event Code Screen contains fields called DSS Unit, Category, Location, Procedure, 
Status, Procedure Synonym, Default Volume, Default Associated Clinic, Ask Reasons and 
Reasons box.  The Reason Box includes buttons for New Reason, Exclude and Include. 

 
Note:  The user cannot edit DSS Unit, Category, Procedure or Location fields from this 
screen. 
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Example:  Add Event Code Screen Sample 

 
 

• Find and select an Associated Clinic. The look-up displays only active locations in the 
HOSPITAL LOCATION file (#44) whose type is “C” (clinic) and is a “count” clinic.  In 
addition, if an Associated Clinic has non-conforming stop codes, the clinic will not be 
selectable.  

 
The following instructions and example assume that the user wants the specified DSS Unit to 
Send Data to PCE. 
 
Instructions to add an Event Code Screen 
1. After selecting a DSS Unit from the dropdown box, click the Add                    button in the 

toolbar or in the Edit menu.  
2. At the appropriate drop boxes select the DSS unit, Category (if applicable, otherwise grayed 

out), Location (one/many/all), Procedure, Procedure Synonym, Status, Default Volume, 
Default Associated Clinic, Ask Reasons, and Reasons (only applicable if Ask Reasons box is 
checked Yes).  

3. Click OK.  
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Example:  Adding an Event Code Screen 

 
 
To Update an Event Code Screen 
1. Select a DSS Unit from the dropdown box.  
2. Click on an Event Code Screen from the list of event code screens for a particular DSS Unit.  
3. In the second screen, update the Status, Procedure Synonym, Default Volume, Default 

Associated Clinic, Ask Reasons and Reasons.  
4. Click OK.  
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Example:  Update an Event Code Screen 
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9.7 Inactivate EC Screen – Identify/Inactivate Multiple Event 
Code Screens 

 
Before the User Starts 
• Users with the ECMGR security key can select an EC Product Code (CPT Code, National EC 

Procedure Code or Local EC Procedure Code) and then display all of the DSS Units using the 
selected Product Code in the Inactivate Selected Event Code (EC) Screens for Given 
Procedure Code.   

• Choose to inactivate Event Code Screens by utilizing the checkboxes in front of each entry.  
The user can display and print a list of Event Code Screens inactivated for a chosen EC 
Product Code. 

 
What the User Will See 
• After selecting the Inactivate EC Screen from the Management Menu, the first screen (Event 

Capture – Inactivate Selected Event Code (EC) Screens for Given Procedure Code) will 
appear. 

• Enter an Event Capture Product Code (CPT Code, National EC Procedure Code, or Local EC 
Procedure Code).  The associated DSS Units with IENs, Locations and Categories appear for 
the EC Product Code selected. 

• Checkboxes are available to the left of each entry.  The user can select multiple checkboxes. 
 
Example:  Inactivate Selected Event Code (EC) Screens for Given Procedure Code 
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Instructions for Inactivating Event Code Screen(s) 
1. Enter an Event Capture Product Code (CPT Code, National EC Procedure Code, or Local EC 

Procedure Code). 
2. The list shows all currently active Event Capture Product Codes.  Use the checkboxes on the 

left side of the screen to select entries to be inactivated. 
 
Example:  Entries Selected to be Inactivated 

 
 
3. Click the Apply                    or OK                  buttons to Inactivate.  
4. A confirmation pop-up will appear.  Click Yes to Inactivate selection(s) or click No to return 

to the previous screen. 
 

Example: Confirmation Pop-up for Inactivate Event Code Screens 
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5. If Yes is selected in response to the confirmation prompt, a listing of the event Code Screens 
that were inactivated will be displayed. 

 
Example:  Event Code Screens That Were Inactivated 

 
 
6. There will be an option to Print                   this list of inactivated screens or click OK                  

to exit back to the first screen. 
 

7. To verify that the Event Code Screens are inactivated, reenter the Event Code Product Code 
that was previously used.  The list of DSS Units, Locations and Categories does not include 
the inactivated Event Code Screens. 
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Example: Verifying that Screens Were Set to Inactive 
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Appendix A - Glossary 
 

Term Definition 
Associated Stop 
Code 

The DSS Identifier (stop code) that most closely represents the DSS Unit 
workload. 

Category Category provides Event Capture a common level to group associated 
procedures. Multiple procedures can be defined for each category. 

Cost Center Cost Center reveals which service is using this DSS Unit. Cost Centers are 
defined in detail in MP4-Part V, Appendix B of the Fiscal service cost 
manuals. 

Conforming 
Clinics 

Clinics that have stop codes in compliance with their restriction types. Stop 
codes are used in accordance to their assigned restriction types. Stops codes 
with restriction type 'P' can only be used in the primary stop code position. 
Stop codes with restriction type 'S' can only be used in the secondary stop 
code position. Stop codes with restriction type 'E' can be used in either the 
primary or secondary stop code position. 

Count Clinic A clinic for which workload entered is credited. 
CPRS Acronym for Computerized Patient Record System 
CPT code Current Procedural Terminology code 
CPT Modifier CPT modifiers provide the ability to refine CPT procedure codes to better 

reflect procedures performed. 
CSV Code Set Versioning 

The Health Information Portability and Accountability Act (HIPAA) 
mandated that applications using CPT codes, CPT modifiers, and diagnosis 
codes should allow users to select codes based upon a date that an event 
occurred.  

DSS Unit A DSS Unit (Decision Support System Unit) defines the lowest level 
segment used for tracking hospital resources. These units can be a small 
work unit within a service or a large division within a service. Management 
at each facility is responsible for tailoring the DSS Units to fit its 
resource/cost reporting. 

DSS Unit Number This code is used for additional identification of DSS Units. 
Event Capture Software designed to provide management tools necessary in tracking 

procedures not entered in other VistA packages. 
Event Code Screen Event code screens are unique combinations of location, DSS Unit, 

category, and procedure that define patient procedures. 
GUI Graphical User Interface 
ICD-9 International Classification of Diseases (of the World Health Organization) 

codes 
Location Initializing the user site as a location, the Event Capture software 

recognizes the user facility as a valid location to enter Event Capture data. 
MAS Acronym for Medical Administration Service, which is now Patient 

Information Management System (PIMS). 
Non-conforming Clinics with stop codes that do not comply with the assigned stop code 
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Term Definition 
Clinics restriction types of P=Primary, S=Secondary and E=Either. 
Non-count Clinic A clinic for which there is no workload credited. 
Ordering Section The medical section ordering the patient’s procedure. 
Parent Service The controlling service for a DSS Unit. 
PCE Patient Care Encounter 
PIMS Patient Information Management System formerly Medical Administration 

Service (MAS). 
Procedure A specific function performed on, or service provided to, a patient. 

Multiple procedures can be associated with a single category. 
Procedure Reason A method of generically grouping patient procedures. 
Provider The provider of care performing the procedure. This provider can be a 

doctor, nurse, technician, or any designated team of medical professionals. 
T&TC 508 Accessibility Testing and Training Center 
Volume Volume is associated with the number of procedures performed. This field 

can also be used to track time actually spent performing the procedures. 
VistA Veterans Health Information Systems and Technology Architecture 
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Appendix B – Synchronizing ECS with VistA 
Scheduling and PCE at the User’s Site 
 
 
Operations and Management (10N) has mandated that all clinical appointments including walk-
ins be scheduled in VistA Scheduling using count clinics. Surgery, Laboratory, and Radiology 
Services feed PCE and NPCD directly from their respective VistA packages and must be 
scheduled with non-count clinics to avoid double-counting. ECS reporting is not used for these 
services. 
 
Non-clinical appointments such as scheduling transportation resources can continue to use non-
count clinics. 
 
DSS site teams and clinical staff using ECS reporting must adhere to the following instructions 
for clinical appointments to ensure coordination with VistA Scheduling and PCE. 
 
1. Create a count clinic in VistA Scheduling for scheduling purposes. 
2. Associate this clinic with the Event Code Screen and DSS Unit using the Event Code Screen – 

Add or Update Event Code Screens option in the Management Menu of the Event Capture 
software. Event Capture uses the Stop Code of the associated clinic to pass workload data to 
PCE. By passing data from Event Capture to PCE, the user will also be sending the data to 
Austin where it is filed in the National Patient Care Database (NPCD). (See Appendix B.) 

3. In DSS do not cost the clinic appointment product. Send it to a DSS statistics department. 
4. When recording workload in ECS, ensure the ECS Procedure Date/Time matches the 

date/time of the scheduled appointment. Complete the required encounter information to 
close out the encounter. 

 
Coordinate and review the above with clinical and administrative staff who use Event Capture as 
well as with Scheduling and PIMS staff. 
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Appendix C - Summary of the PCE Filing Process 
 
 
Follow these steps to define an associated clinic for each event code screen that has DSS Units 
marked to send data to PCE. The options mentioned can found in the Event Capture Management 
Menu. 
 
1. Use the DSS Unit – Add or Update DSS Units option to update the SEND TO PCE 

information for each DSS unit.  
2. Use the Event Code Screen – Add or Update Event Code Screens option to create new event 

code screens or to modify existing event code screens. 
 
The DATE/TIME OF PROCEDURE field (#2) of the EVENT CAPTURE PATIENT file (#721) 
requires the entry of both date and time as part of every procedure date.  
 
Users must provide the following information for each procedure during data entry. 
 
• ICD-9 Diagnosis Code 
• If the selected patient has multiple eligibilities, users will be prompted to select the eligibility 

that applies to the specified procedure. The PRIMARY eligibility is displayed as the default. 
• A response to the classification questions for patient procedures is required only if they apply 

to the patient. 
• If a procedure is associated with a CPT code, then users will be prompted to enter CPT 

modifiers. 
• Associated Clinic 
 
After the PCE-related prompts are answered, all appropriate patient records are formatted to file 
the data with PCE. This formatted data string is stored in the PCE DATA FEED field (#30) of 
the EVENT CAPTURE PATIENT file (#721). The flag to file this record is then set in the SEND 
TO PCE field (#31) of the EVENT CAPTURE PATIENT file (#721). 
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Appendix D - Other ECS Package Management 
Information 
 
How to set up an ECS email group 
Set up an ECS mail group in VistA to receive relevant ECS notifications.  Contact IT to set up a 
VistA ECS Mail Group to be able to  have more than one person receive ECS  administrative 
messages. 
 
Examples of ECS package administrative Email messages: 
1. When a new ECS patch is released. 

Example A 
Subj: PATCH EC*2.0*XXX UPDATE TO EC NATIONAL PROCEDURE (#725) 
FILE[#XXXXXXXX] 
DD MMM YYYY 07:54:22 -0500 (CDT)  338 lines 
From: <PROTECTED EMAIL ADDRESS>  In 'PATCHES FOR DSS' basket.   Page 1 
--------------------------------------------------------------------------- 
This patch in now in all TEST accounts and will be installed into  
PRODUCTION on TUE DATE by 8am CST.  Post install information will be  
forwarded to DSS.  Thank you for your review of this patch, if you have  
any questions call me.  NAME PHONE. 

 
$TXT Created by YYYYYY,XXXX at <PROPTECTED EMAIL ADDRESS>  (KIDS) on  
Wednesday, MM/DD/YY at 12:18 
========================================================================== 
Run Date: MMM DD, YYYY                     Designation: EC*2*XXX 
Package : EC - EVENT CAPTURE                  Priority: Mandatory 
Version : 2       SEQ #XXX                      Status: Released 
                  Compliance Date: MMM DD, YYYY 
========================================================================== 
Associated patches: (v)EC*2*YYY    <<= must be installed BEFORE `EC*2*XXX' 
 
Subject: UPDATE TO EC NATIONAL PROCEDURE (#725) FILE 
 
Category:  
  - Other 
  - Routine 
 
Description: 
============ 
 
 This patch addresses 1 issue: 
   
 1. Updates the EC NATIONAL PROCEDURE (#725) file: it adds 23 
    new procedure records, inactivates 16 existing procedure records, and 
    updates names and codes for 49 others. 
    
 Associated NSR(s): 
------------------   . . .  
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Example B 
Subj: EC*2.0*XXX INSTALLATION  [#XXXXXXXX] DD MMM YYYY 14:53:26 -0500 (CDT) 
10 lines 
From: <PROTECTED EMAIL ADDRESS> 
In 'PATCHES FOR DSS' basket.   Page 1 
--------------------------------------------------------------------------- 
PACKAGE INSTALL 
SITE: <EMAIL ADDRESS PROTECTED> 
PACKAGE: EVENT CAPTURE 
VERSION: 2.0 
Start time: MMM DD, YYYY@14:53:26 
Completion time: MMM DD, YYYY@14:53:26 
Environment: TST^ROU^XXXXXXX^ROU:XXXXXXX^FTP/KIDS^Released EC*2*XXX SEQ 
#XXX 
Installed by: NAME^XXX 
Install Name: EC*2.0*XXX 
Distribution Date: MMM DD, YYYY 
 
Enter message action (in PATCHES FOR DSS basket): Ignore//  

 
2. When an EC NATIONAL PROCEDURES file (#725) patch is loaded.  (A review of  the 

EVENT CODE SCREENS file (#720.3) is performed.  Event Code Screens which have 
either inactive CPT codes,  inactive Event Capture Codes, or an Event Capture Code 
with an inactive “default” CPT code attached, are reported.) 

Example 
From: <EMAIL ADDRESS PROTECTED> 
Sent: Monday, MONTH DD, YYYY 9:00 PM 
To: Package Manager 
Subject: Event Code Screens to Review 
 
Please forward this message to your local DSS Site Manager or Event Capture 
ADPAC. 
 
A review of the EC EVENT CODE SCREENS file (#720.3) was done after 
installation of patch EC*2*XX which updated the EC NATIONAL PROCEDURE file 
(#725).  This message provides the results of that review. 
 
The EC EVENT CODE SCREENS file (#720.3) records indicated below point to an 
inactive record in the EC NATIONAL PROCEDURE file(#725) or to an inactive 
record in the CPT file (#81). 
 
The user should use the Inactivate Event Code Screens [ECNACT] option to 
inactivate the Event Code Screen.  If necessary, a new Event Code Screen 
can be created using a currently active CPT code or National Procedure. 
 
The CPT procedure for the following Event Code Screen (XXX-X-X-XXXXX) is   
inactive -- 
  Location:  VAMC 
  Category:  Treatment 
  DSS Unit:  E-KINESIOTHERAPY-IP 
  Procedure: PROSTHETIC TRAINING (97520) 
 
The CPT procedure for the following Event Code Screen (XXX-X-X-XXXXX) is 
inactive -- 
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  Location:  VAMC 
  Category:  Treatment 
  DSS Unit:  E-KINESIOTHERAPY-IP 
  Procedure: PROSTHETIC CHECKOUT (97703) 
 
The CPT procedure for the following Event Code Screen (XXX-XX-X-XXXXX) is 
inactive -- 
  Location:  VAMC 
  Category:  None 
  DSS Unit:  PSYCHOLOGY-IP 
  Procedure: PSYCHOLOGICAL TESTING (96100) 

 
Note: 
After a patch updating file #725: 
Check for inactivated national EC Procedure Codes. 
Check for Event Code Screens with out-of-date EC Procedure Codes. 

 
 
3. When an ECS User is terminated. 

 (May inactivate national EC Procedure Codes and report any Event Code Screens with out-
of-date Procedure Codes.) 

Example 1 
Subj: Removed Terminated Users from DSS UNIT Access  [#XXXXXXXX] MM/DD/YY@02:30 8 lines  
From: EVENT CAPTURE  In 'IN' basket.   Page 1  *New*  
-------------------------------------------------------------------------------  
Event Capture - Terminated Users removed from DSS UNITS  
 
Total number of Terminated users: 1  
 
DSS UNITS           NAME of Terminated User Removed from DSS UNIT  
-----------------------------------------------------------------  
CHAPLAINS           Facility Staff Name  
   
Enter message action (in IN basket): Delete//   
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Example 2 
Event Capture - Terminated Users removed from DSS UNITS 
 
Total number of Terminated users: 1 
 
DSS UNITS           NAME of Terminated User Removed from DSS UNIT 
----------------------------------------------------------------- 
HCBC REFERRALS/STATS PROVIDER1, EC 
  
HCBC STAFF PHONE    PROVIDER1, EC 
  
HCBC STAFF PHONE NOT W/PT PROVIDER1, EC 
  
HCBC VA STAFF       PROVIDER1, EC 
  
SOCIAL WORK – INPATIENT PROVIDER1, EC 
  
SOCIAL WORK – OUTPATIENT PROVIDER1, EC 
  
SOCIAL WORK-C&P     PROVIDER1, EC 
  
SOCIAL WORK-GEM     PROVIDER1, EC 
  
SOCIAL WORK-PHONE NOT W/PT PROVIDER1, EC 
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